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Introduction to Samvad 
Opening Samvad 
Samvad Shortcut should be automatically created on your desktop at the time of installation. If it 
does not, follow the steps below: 
1. Click Start on the Windows task bar. 
2. Select Programs. 
3. Select Samvad. 

 
The Samvad Window 
Samvad enables you to create, edit, and run scripts of any length, at multiple speeds, and in a 
variety of colors. The Samvad software can be divided into three main segments: 

• Run order: Collection of stories. 

• Control Panel: Used for prompting operations 
• Editor: Used to import, write, and edit scripts. 

 
The Samvad Menus and Toolbars 
Samvad has tabbed menus and toolbars, which appear at the top of main 
window 
 
 

 
 

Samvad Main Window 

Tabbed Menu 

Toolbar
s 



 
Run Order Tab: Buttons and menus 

New Run order: Creates a blank run order using the create dialog box 

Open Run order: Opens an existing run order using the Open run order dialog box. 

Delete Run order: Deletes an existing run order using delete runorder dialog box. 

Schedule Run Order: Schedules an existing runorder using scheduling dialog box. 
 
Story Tab: button and menus 

New: Opens a blank story in the editor 

Edit: Opens the currently selected/highlighted story of the run order, in editor for editing.  

Old Story: Adds an existing story into the current run order using the old story dialog box.  

Add Image Story: If camera or scanner is attached to the system, then it opens up the 
relevant dialog box for taking pictures/scans and adding them to the currently open run order.  

Import: Imports html/word/text file, and adds it to the currently open run order. Formatting 
in imported files may result in improper functioning. Hence, it is recommended to check 
imported files once before final prompting. 

Delete : Deletes the highlighted/selected story from the run order. 

Move UP: Moves the selected/highlighted story one position up in the run order. 

Move Down: Moves the selected/highlighte story one position down in the run order. 
Commands Tab: buttons and menus: 

Play: Starts prompting of the currently open run order. 

Pause: Pauses the run order currently being prompted. Prompting can be started again by 
pressing play. Prompting will start from the exact position where it was paused. 

Stop: Stops the currently playing run order. Once stopped, the run order will begin 
prompting from the start, when play is pressed. 

Skip: Takes the currently playing story to its end position. 

Breaking News: This option is used for inserting stories in a run order which is already 
playing. It opens up a blank editor for scripting the story. On saving a dialogue box asks for the 



position of the story. The story is inserted at the specified position or at the earliest position 
possible, if the specified position is no longer available. 

Scroll Up: Sets the scrolling direction upwards.  

Scroll Down: Sets the scrolling direction downwards. 

Type N Play: Type N Play allows you to prompt as you write the story in editor. This 
feature is enabled only when a run order is playing. Type N play, stops the playing runorder and 
opens an editor windows for scripting the story. Prompting starts as soon as the editor is open, 
and whatever is written on the editor thereafter is prompted in real time. To go back to the 
preiously playing run order press resume run order button on the editor or the main window. 
Once resume run order is pressed, the editor is no longer available for editing. Entire text in 
editor is prompted and thereafter prompting continues from the exact point where control was 
shifted to type N Play.   

Live Edit: Live Edit is similar to Type N Prompt in the sense that it allows you to edit text 
in real time. The major difference being, that instead of scripting a new story, live edit gives you 
the option of editing the currently playing story. Live Edit opens up the currently playing story in 
the editor, and is similar to Type N prompt thereon. On completion of Live Edit, run order 
resumes from the next story in the run order.  
 
View Tab: buttons and menus 

TP Preview: TP Preview enables the preview screen for the operator/producer. Preview 
screen is meant for guiding the operator by replicating the screen visible to the reader. Operator 
can con control position, speed etc using the preview screen. 

Control Panel: Control Panel is a small floating control, that can be used to control the 
prompting operations of the teleprompter. Pressing “ Control Pnale” button, enabled the control 
panel.  

Story Preview: Story Preview is a small window that opens up side by side the run order. 
It displays the content of the highlighted/selected story in the runorder. Story preview windows 
can be enabled/ disabled using the story preview button. 
 
Settings Tab: Buttons and Menus 

Mirrored: Sets the Teleprompter‟s prompting setting to mirrored. This is the normal setting 
to be used when the teleprompter is being used with its glass hood. 

Unmirrored: Sets the Teleprompter‟s prompting setting to unmirrored. This is the normal 
setting to be used when the teleprompter is being used without its glass hood. 
 

MOS: Opens up the MOS settings window. See MOS Settings for more details. 



Users:  Opens up user management dialog. Users can be added/deleted/modified using 
it. See user management for more detail. 

Readers: Opens up the reader management dialog box. Readers can be 
created/edited/deleted using it. See Reader management for more detail.  

Hand Control: Enables/Disables the USB hand control device.  

Foot Control: Enables/Disables the USB foot control device. 

Serial Foot control: Enables/Disables the serial foot control device. 
 
General Tab: Buttons and menus: 

Uninstall: Uninstalls the software from your system and generates an un-installation key. 

Help: Opens Samvad Help. 

About: Displays information about the software. 

Exit : Saves current settings and exits the application. 



 

Samvad Basics 
Customizing The Samvad Window 
Repositioning Run order Columns 
Samvad run order‟s fields can be customized as per the user preference. To change the order 
of fields: 
1. Click and hold on the area in the column header. 
2. Drag it to the desired location. 
3. Release the mouse button once it is in the desired location. 
4. Repeat steps 1-3 until all the columns are where you‟d like them to be. 
Run order columns will appear in this order only, until you re-position them again. 
 
Resizing Windows 
To resize your runorder/editor window, just position the cursor in the corner or on the sides of 
the window until you see a double-arrow symbol then resize the window accordingly. 



 

Samvad Basics 
Opening a Run order 

1. Opening a new Run order 
a. Select Run order Tab 

b. Click On „New Run order‟ button  
c. A Create Run Order Dialogue Box will appear. Enter the details, and click OK. 

 
Create Run Order Dialogue 
 

d. A blank run order will be opened. 

2. Opening an existing run order 
a. Select Run order Tab 

b. Click On „Open Run order‟ button  
c. Open Run Order Dialogue Box will appear. Select the Run order from the list and 

click OK. 

 
    Open Run Order Dialogue 
 

d. Selected Run order will be opened. 

Editing a Run order 
1. Adding a new story 

a. Select Story Tab 



b. Click on New Button  
c. A blank Editor will open up. 

 
Blank Editor 

d. Write the text of the story. 

e. When you are done editing, Click Save . 
f. A dialogue box will appear. Enter the story name(story names should be unique), 

and click OK. 
g. Editor will close , and story will be added to the open run order. 

2. Adding an old story 
a. Select Story Tab 

b. Click on Old Story Button  
c. A dialogue box with list of all existing stories will open up. Select the story you 

wish to add to the open run order, and click OK. 

 
Old story Dialogue Box 

d. The story will be added to the open run order. 



3. Importing a story 
a. Select Story Tab 

b. Click Import Button . 
c. A file browser will appear. Select the file you wish to add as story. 
d. The file will be added to the runorder. 

4. Adding an Image story 
a. Select Story Tab 

b. Click Image story Button . 
c. If an installed web camera or scanner is detected on the system, its interface will 

appear. Use the interface to click a picture or take scans. Save them, in Directory 
C:/Samvad. Click ok. 

d. Files will be added to the run order and removed from the directory c:/Samvad. 

 
5. Editing an existing story 

To edit an existing story, do either of the following: 
a. Double click the story, and it will open up in the editor. 
b. When You are done editing, Click Save to save the changes. 

OR 
a. Select the story in the run order, so that its row is highlighted. 
b. Select the Story Tab. 

c. Click the edit button  
d. Story will open up in editor for editing. 

e. When you are done. Click save  to save the changes. 

6. Re-ordering Stories 
To re-order stories in a Run order, do the following. 
a. Move Story UP 

a. Select the story in the run order, so that its row is highlighted. 
b. Select the Story Tab. 

c. Click Move Up button . 
d. Story will be moved one position higher in the run order. 

b. Move Story Down 
i) Select the story in the run order, so that its row is highlighted. 
ii) Select the Story Tab. 

iii) Click Move Down button . 
iv) Story will be moved one position lower in the run order. 

 



Editor Operations 
 

 
Editor Window 

 
 
Formatting The Text 
 
To change text formatting, use the Font, Font Color and Background color Tab dialog boxes 
from the menu. You can also use the toolbar for some formatting shortcuts. 
Before you apply formatting, select the text you want changed: 
• To select the entire Script, select Select All from the Edit menu. Alternatively you can use 
Ctrl+A. 
• To select part of the text, click and drag the mouse over the text you want formatted. 
 
Changing Fonts 
Click the Fonts button on Editor Toolbar or Select Font from Format menu on Editor window. 

Use the Font dialog box to change the font type and size. 
To change the font (using the dialog box): 

(1) Select Font from the Format menu to open the Font dialog box. 
OR. 

To change the font (using the toolbar): 
(1) Click the Fonts button to open the Font dialog box. 
 
(2) Make any necessary adjustments to the Font‟s typeface, style, and size in the 
appropriate lists. 
 



 
 
 
Use the following toolbar buttons for styling the script 

 Bold , Italic , or Underlined  

 Font Color  

 Background Color  
 

 
Saving a Story 
 
To save under the current file name: 

1. Click  . 
 OR 
2. Select Save from the File menu. 
 
To save a script locally on the system: 
1. Select Save As from the File menu. This opens the Save As dialog box. 
2. Browse to the location, where you wish to save the file.  
3. In the File name box, enter the file name. 
4. Click Save. 
 
The file will be saved at the selected location as an html file. 

 
AutoText : 

 
This feature enables quick insertion of frequently used lines and phrases. 
Auto text entries can be easily created, saved and assigned shortcut keys. To view auto text 
toolbar, select Auto text from the View menu in editor.  Auto text Toolbar will appear on the right 
side of the editor.  
To add an auto text entry, on auto text toolbar, select new and then write the text in the auto text 
toolbars editor. Assign a shortcut key and press save. The new entry will appear start appearing 
in the list of auto texts, visible at the bottom left of the auto text toolbar.  

 
  



Teleprompting Operations 
Prerequisites: Run Order to be prompted, should be open. Hardware 
should be properly connected. 
To start prompting, do the following: 

1. Pre prompting Settings: Following settings should be done before beginning to prompt. 
i) Setting TP Preview: TP Preview allows the operator to view the display visible to 

reader. This preview is completely synchronized with the reader‟s display. TP 
preview can be enabled/disabled as per choice. To enable/disable TP preview do the 
following: 
a. Go to Settings Tab 

b. If you see “TP Preview” , then click it to enable TP Preview, else do nothing. 
TP Preview will be enabled.   

c. If you see “Disable TP Preview” button, then click it to disable TP Preview, else 
do nothing. TP Preview will be disabled. 

ii) Setting, mirrored/un-mirrored settings 
a. Go To Settings Tab 

b. To enable mirrored display, click mirrored button . By default, mirrored 
option is enabled. Mirrored text should be used, when TP is being used with 
glass hood. 

c. To disable mirrored display, click un-mirrored button . Mirrored setting 
should be disabled only, when teleprompter is not being used with glass hood. 

iii) Setting Font size 
a. Font size can be set from control panel. If Control panel is not visible , then : 

1) Go to View tab. 

2) Click Control Panel button . A square panel should become visible. 
b. Set the font size using „Font Size‟ labeled drop down box. A higher font size 

corresponds to bigger text size while teleprompting.  
Note: Text size set in the editor has no effect on the text size used while prompting. 

 
2.  Prompting 

i) Start Prompting 
a. Click Play button on the control Panel to start prompting 

OR 
b. Go To Commands Tab 

c. Click „Play „ button  
 

ii) Pause 
a. Go to Commands Tab 

b. Click „Pause‟ button  
OR 

a. Click Pause on Control panel 



iii) Change scrolling Direction 
a. Go to Commands Tab 
b. Click scroll up/scroll down to change scrolling direction to up/down 
OR 

a. Click scroll up /scroll down  button from control panel to change scrolling 
direction. 

iv) Moving to previous Story 
a. Go to Commands Tab 

b. Click Skip button   
 

v) Skip Story 
a. Go to Commands Tab 

b. Click Skip button   
vi) Insert Breaking News 

a. Go to Commands Tab 

b. Click Breaking News button  

c. Editor will open up. Write the story, and click Save button  on editor 
d. A dialogue box will open up. Specify the story name and position. Click OK. 
e. Story will be inserted at the specified position. 
Note: Breaking news cannot be inserted at any position before queued/last played 
story. In case, the position specified lies before the queued/played story, then story 
will be inserted at the earliest possible position. 

vii) Use Type N Prompt 
a. Go to Commands Tab 

b. Click Type N Prompt button  
c. Editor will open up. 
d. Write the story on editor. It will be prompted as you type. 

e. When you have completed the story. Click „Resume Run order‟  button on 
editor or in Commands Tab. 

f. You will be prompted for the story name. Specify the story name and click Ok. 
g. Story will be saved in Type N prompt run order. 
h. When the entire Type N Prompt story has been prompted, the run order will 

resume from exact point, where control was shifted to Type N Prompt.  
Note : Preview at the side of Type N Prompt Editor, is only indicative and may not be 
exact. 

viii) Use Live Edit 
a. Go to Commands Tab 

b. Click Live Edit button  
c. Editor will open up, with the currently playing story loaded into it. 



d. In this mode, the prompting continues as you edit. 
e. Changes in text will be reflected in prompting. 

f. When you are done editing, Click „Resume Run order‟ button  on editor or 
Click „Live Edit Complete‟ button on Commands Tab. 

g. When the entire story as visible in editor has been prompted, the run order will 
resume from the next story.  

Note : Preview at the bottom of Type N Prompt Editor, is only indicative and may not 
be exact. 

ix) Stop 
a. Go to Commands Tab 

b. Click Stop button.  
OR 

a. Click Stop on Control Panel. 
x) Scrolling Speed Control 

Scrolling Speed can be controlled from Control panel. Scrolling speed has been 
categorized in 5 categories: Very Fast, Fast, Medium, Slow and Very Slow. Within 
each category, speed can be further refined using the „Fine Tune‟ track bar on the 
control panel. 
 
 
 
 
 

 
 

 
 

Scrolling 
Speed 
Categories Play/Pause 

Change scroll 
direction 

Skip 

Stop 

Speed 
Fine 
Tunin
g 

Font Size 
Selector 

Previous 



Other Operations 
1. Adding/Deleting/Modifying Users 

a. Go To Settings Tab 

b. Click Users Button  
c. A dialogue box will open up. 
d. You can add, delete, modify users by clicking the appropriate buttons 

2. Adding/Deleting/Modifying Readers 
a. Go to Settings Tab 

b. Click Readers button  
c. A dialogue box will open up.  
d. You can add, delete, modify readers by clicking the appropriate buttons 

 
Further details about reader operations is given under the section “Reader Management”. 

 
Understanding Run Order in detail 

 
1. Sno: Serial Number of the story 
2. Story Status: A story can be marked incomplete by setting the story status to incomplete. 

Incomplete stories are highlighted, and can be easily distinguished from complete stories. 
Once a stories is complete its status can be set to complete and highlighting is removed. 

3. Story Title: Name of the Story. A title cannot contain special characters: colon(:) and single  

1 2 3 
4 5 6 7 8 11

2 

9 10 
12 



4. quote(„) and length of story title should be less than 50 characters  
5. Estd Time: Estimated time (in seconds) required for the entire story to be played. This time 

is calculated based on words in the story and reading speed specified for the story. 
Reading speed is displayed in the column W/M. 

6. Block Story: A story can be blocked by checking the box under column Block. A blocked 
story is automatically skipped during prompting. All Blocked stories are marked in red. 

7. Word Count: Number of words in the story 
8. Start Time: Expected Start Time of the story. Expected Start Time of the first Story is 

00:00:00. This time is only for reference purpose of the operator. Actual time of start may 
differ. 

9. Story Reader: Stories can be assigned to readers defined in the system. Once a story has 
been assigned to a reader, settings defined for that reader i.e. background color, font color, 
text size, scrolling speed etc become automatically applicable to that story. For example if 
story “ ABC”  is assigned to reader1 and reader1 has font color specified at yellow and 
prompting speed specified to medium high, then story ABC will automatically be prompted 
in yellow text color, and prompting speed will automatically shift to medium high at the start 
of the story.  

10.  W/M: Reading Speed in words per minute of the reader assigned to story. If no reader is 
assigned, default reading speed is displayed. 

11. Clip Name: If any audio/video clips are to be played after/during the script, then its name 
and length can be specified. Clip Name is to be specified in this column. Contents of this 
column are meant only for reference purpose 

12. Clip Length: Length of the clip in seconds. This time is used in the calculation of start time 
of the next story.  

13. Story Progress Bar: Story Progress bar shows the progress of story in playing conditions. 
It represents graphically the proportion of story that has already been prompted.  

 
 

Reader Management 
Readers in Samvad give the flexibility of storing different profiles. They can represent actual 
news anchors or can be used to represent frequently used prompting settings. Readers give the 
option of storing a combination of following settings: 

 Background color 

 Text Color 

 Text Size 

 Prompting Speed 

 Reading Speed 
 
A reader can set any of the above settings to a particular value, and then that setting becomes 
automatically prevalent in stories assigned to that reader. For example if text color is set to red 
for reader XYZ, then all stories that have been assigned to reader XYZ will be prompted in red 
color. 
A story which has not been assigned to any reader continues to be prompted at the default 
settings of the system. 
 
A story can be assigned to a reader by selecting the reader in reader column of the run order. 
A story can be assigned to one reader at max. 
 



Reader settings overrule the default formatting, but not the story formatting. For example: If a 
story has been saved with text color set to yellow, and then it is assigned to reader XYZ, whose 
text color is red, the story will be prompted in yellow, because story formatting overrules reader 
formatting. For reader text/background color formatting to be effective, stories should be saved 
in default font/background color. 
 
To create and manage readers, go to settings tab and click „Users‟ button. 
Enter appropriate values in the following buttons, as per the the instructions given below: 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
To create a new Reader, enter the values in new reader section and click create. 
 
To update an existing reader, select the reader from the drop down list, then modify the relevant 
values in new reader section and click update to save the changes. 
 
Properties in the new reader section are explained below: 
 

Reader name: This the name of the reader. This name is to be used for selecting the reader in 
the drop down available on the run order. Two readers cannot have same name. 

Text Size: This is the size of the font for the reader. Stories for the given reader will be 
automatically prompted in the specified text size irrespective of the font size selected at the 
control panel. 

 



Background Color: This the color used at the background of the story text while prompting.  

Text Color: This is the color of the story text . 

Reading Speed: This is the raeding speed of the raeder in Words per Minute. This speed is 
used to calculate the expected time to be taken for the story. If no speed is specified, a default 
speed of 150 wpm is used to tiem the script. 

Prompting Speed : This is the speed at which user would like the story to be prompted. If this 
is set , then as soon as the prompting shifts to a story of the given user, prompting speed will 
automatically change to the selected speed at the start of the story. Later on speed can be 
manually changed by the operator or the reader.  

To set this speed, open a run order , and then press, preview speed. The run order will start to 
play. Adjust the speed according to the reader, and press set speed button on reader form. The 
prompting speed button will show a numerical equivalent of the selected speed. Press, create or 
update, whichever appropriate to save the speed.  

 

MOS Configuration 
 
Samvad M.8.01 supports MOS protocol and can easily be used in integration with NCS for 
smooth operations. 
 
To configure MOS on Samvad, Go to Settings Tab and select MOS button. It will open the 
following form where properties for MOS protocol can be configured. 
 
 

 
 
 
MOS ID: This is the name for the teleprompter, by which other MOS devices can identify the 

teleprompter. If you are not sure what to enter here, write “ SAMVAD” here.  



However two MOS devices cannot have the same MOS ID, so if you are using two 
or more samvad teleprompters, write “SAMVAD1”, “SAMVAD2” and so on. 

 
MOS IP Address: This is the IP address(IPv4) of the machine where samvad is running. 
 
Lower Port : This the lower port for MOS protocol. If you are not sure of what to use here, write 

10540. This is the default lower port. 
 
Upper Port: This is the upper port for MOS protocol. If you are not sure of what to use here, 

write 10541. 10541 is the default upper port for MOS.  
 
NCS Details: 

NCS ID: This is MOS Id of the NCS. 
BUDDY ID: This is the MOS Id of the buddy NCS. Buddy NCS are a feature of ENPS 

system. If your NCS does not have a buddy NCS, leave this field blank. 
NCS IP: This is the IP address(IPv4) of the system running as NCS. 
BUDDY IP: This is the IP address(IPv4) of the system running as Buddy NCS. 
Upper Port: This is the upper port defined for the NCS. 
Activated: Check this box to activate the settings for a given NCS. If this box is not 

checked, Samvad will not communicate the given NCS. Restart application 
after activating a NCS for settings to take effect.  

NCS Type: Type of NCS such as ENPS,OCTOPUS etc. 

Working With Accessories 
 

1. USB Hand Control : Operations such as Play, Pause, Skip, Speed Control and Scrolling 
Direction can be controlled with the use of Hand Control. Hand Control is an optional 
item. If you have purchased Hand Control, you need to install it first. 
a. Installation 

i. Connect the Hand Control to a USB port on your System or Samvad Box 
ii. Insert Samvad Installation CD/USB drive and open the installation menu. 
iii. Click install „USB Controls‟ button on the Samvad installation menu. 
iv. Installation of USB controls will start. System may take a minute or two to 

complete installation. 
v. After installations completes successfully, start Samvad software. 

b. Operations 
i. Go to Settings Tab. 

ii. Click USB Hand Control button . 
iii. A notification should appear in the system tray, stating” USB Hand Control 

Enabled”. You can now use your hand control. 
iv. If the notifications does not appear, un-plug your hand control. Re-insert your 

hand control in the USB port, and re-start Samvad software. Now try enabling 
the hand control again. 

v. If the notification still doesn‟t appear and your hand control is not functioning 
properly, then probably, USB Controls have not been installed properly. Re-
perform the installation. 

2. Foot Control: USB Foot control and Hand Control have the same installation. If you have 
already installed USB hand control, then proceed with the operations of USB foot control 



, otherwise follow the steps given in USB hand Control installation, before proceeding 
with USB foot control Operations 
a.  Go to settings Tab. 

b. Click USB foot control button . 
c. A notification should appear in the system tray, stating” USB Foot Control Enabled”. 

You can now use your foot control for controlling speed, play/pause and toggle 
direction. 

d. If the notification does not appear, un-plug your foot control. Re-insert your foot 
control in the USB port, and re-start Samvad software. Now try enabling the foot 
control again. 

e. If the notification still doesn‟t appear and your foot control is not functioning properly, 
then probably, USB Controls have not been installed properly. Re-perform the 
installation. 

3. Serial Foot Control. Serial Foot Control does not need any installation. Simply connect 
the serial foot control to a serial port on your system and it is operational. If you do not 
have a serial port in your system, you may have to insert a serial card in your system. 
a. After connecting the serial foot control to system. Go to Settings Tab. 

b. Click USB Serial foot control button  
c. Your serial control is now enabled 


